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Start-Up 
 
After entering Windows, click on the desktop icon SMART 
Board Tools.  The SMART Board icon will appear in the 
system tray on the bottom right of the screen.  Turn on the 
projector and have the source control (panel found next to 
door) set to Laptop.  The Laptop screen should now be 
projected onto the SMART Board.  The SMART Board will 
now have full interactivity.  Clicking on the icon in the 
system tray will bring up the SMART Board Menu. 
 
Most SMART Board functions are opened from the 
SMART Board Menu.  If you are continually switching 
between various SMART Board functions, you may want 
to open the Start Centre which sits permanently on the 
right hand side of the screen, rather than having to 
constantly click on the SMART Board icon in the system 
tray to bring up the menu.  To open Start Centre click on 
the SMART Board icon and select Start Centre. 
 
Interacting with the SMART Board 
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With the SMART Board Tools open, you will be able to interact with the projected image of the 
laptop on the SMART Board.  The SMART Board becomes a touch-screen interface, allowing 
you to control the laptop from the SMART Board.  By using the SMART Board markers you will 
also be able to write annotations over programs/images/files that are projected onto the SMART 
Board, and save these annotations in a file on the computer attached to the SMART Board. 
 
Orienting the SMART Board 
 
Performing an orientation procedure will provide the SMART Board with the information to 
accurately track touch-screen interaction.  Orientation should also be performed if the screen 
has been moved or bumped, or has been unplugged from the computer since last usage.  The 
orientation procedure asks the user to press the area of the SMART Board where a cross 
appears.  Three orientation levels are available (Quick, Standard, and Fine).  The default is 
Quick orientation. 
 
To configure which orientation level you want to use, click the SMART 
Board icon in the system tray and select Control Panel.  Then select the 
Align/Orient the SMART Board option.  Now select the Pick the 
Orientation Precision option.  Quick level offers 9 points of contact 
orientation, Standard offers 20 points, and Fine offers 80 points.  Click the 
Orient button.  When prompted, touch the area of the SMART Board 
where the cross appears. 

 



The SMART Board Pen Tray 
 
The SMART Board Pen Tray is situated directly under the SMART Board.  On this tray the four 
SMART Board markers plus the eraser sit.  Also situated on the pen tray is two buttons on the 
right.  The top button is the Keyboard, which brings up the SMART Keyboard function that is 
discussed in detail later in this reference guide.  The other button is the Right Mouse Button 
Click function.  By pressing this button, the next time you touch the SMART Board it will react 
as if you have clicked on the screen with the right mouse button. 
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Using the markers on SMART Board 
 
Start up the application and file that you wish to project from the laptop onto the SMART Board.  
Pick up the marker for the colour that you wish to use from the pen tray.  To write in a different 
colour, place the marker that you are currently using back on its proper slot on the pen tray 
before picking up the next marker.  This is to ensure that the next time something is written on 
the SMART Board, the previous colour is not used.  To erase writing on the SMART Board, 
place the marker that you are using back in its proper slot before using the eraser.  In terms of 
what colour will appear when writing on the SMART Board, the SMART Board will reference 
which marker is not currently placed in the pen tray.  The illuminated lights on the pen tray show 
which marker or eraser is currently in use. 
 
To clear all annotations that you have made on the SMART Board, ensure all 
markers and the eraser are in the pen tray and simply touch the screen.  When 
the screen is touched with all markers in the pen tray the board will automatically 
be cleared.  If you accidentally touch the screen in this instance and the screen is 
cleared, the Restore Annotations button will appear in the bottom right of the 
screen.  Touch this button to restore the annotations to the board. 
 
Configuring the SMART Board markers 
 
The markers can be reconfigured to alter line thickness, colour, line type, 
or opacity.  Click the SMART Board icon in the system tray to bring up 
the SMART Board menu, and then select Control Panel, or the Control 
Panel button in the Start Centre.  Then click on the Pen Tray Settings 
option.  A list of buttons will appear on the left hand side panel 
corresponding to which marker you wish to reconfigure.  The eraser can 
also be configured here to set a different diameter. 
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Floating Tools 
 
The Floating Tools offer a customizable range of tools to perform a variety of operations.  You 
have access to the same tools from the Pen Tray to use on the SMART Board, but instead in 
virtual rather than physical form. 
 
To open Floating Tools click the SMART Board icon and select Floating 
Tools, or the Floating Tools button in the Start Centre.  You will be able to 
click and drag the Floating Tools toolbar to any part of the screen.  If you 
select the pen icon from the Floating Tools menu, you are now able to write 
on the SMART Board with your finger, rather than having to use the marker. 
 

 
Floating Tools Menu 
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In addition to the tools offered by the Pen Tray, the Floating Tools menu also offers features 
such as a large screen pointer, restore/clear annotations, and save/print screen.  To customize 
what tools are shown in the Floating Tools Menu, click on the More Options icon .  This will 
open the Customize Floating Tools box which shows all tools that are available.  To put 
additional tools in the Floating Tools Menu, click on that tool in the box on the left and click the 
Add button.  To remove tools from the menu, click on that particular tool in the box on the right 
and click the Remove button. 
 
SMART Keyboard and Handwriting Recognition 
 
While you will mostly use the SMART Board for writing over applications with 
the markers, there will be situations where you will need to use a keyboard 
to send commands to the computer.  For this you can use SMART 
Keyboard function, so you can remain at the SMART Board to type rather 
than having to use the computer keyboard.  The SMART Keyboard can be 
opened by clicking on the SMART Board Tools icon, and selecting 
Keyboard.  You can also open the SMART Keyboard by pressing the 
keyboard button on the pen tray of the SMART Board, or the Keyboard 
button in the Start Centre. 
 

From SMART Board 
menu 

 

 
From Start Centre 

Included in the SMART Keyboard option is the Handwriting Recognition Window.  In this 
window, you can write the information that you want typed on the screen with one of the 
markers, and the SMART Board will convert your handwriting to typed text.  When using 
Handwriting Recognition Window, you can also specify whether you are typing in capitals or 
writing a number by clicking the appropriate circle next to that option.  This helps the SMART 
Board to interpret handwriting for letters or numbers that look similar, eg. S and 5.  The area in 
the Handwriting Recognition Window where you write your text is called the Writing 
Recognition Area.  The converted text will appear above your written text in the Editing area.   
 
To open the Handwriting Recognition Window function, click the drop-down 
menu in the top left corner of the SMART Keyboard window and select Write. 
 



 
There may be occasions when the SMART Board is unsure of 
what letter or number you have written.  On these occasions a 
question mark will appear instead of that letter/number in the 
editing area.  To edit the conversion, touch the screen on the 
question mark in the editing area.  This character will then be 
highlighted.  Once again write this character in the Writing 
Recognition Area.  If the program understands what character 
you have written, it will replace the highlighted question mark in 
the editing area with that character.  The SMART Board is 
much more likely to recognize large handwriting than small and 
cramped handwriting. 

 

 
To insert additional text to the editing area, touch the editing area where you want to add the 
additional text.  Then write in the Writing Recognition Area the text you want to add.  To delete 
text, touch on the text in the editing area that you want removed, and press the Back button.  
To change lower case characters to upper case and vice versa, touch on the screen the 
character in the editing area.  The letter will appear highlighted with an arrow pointing either 
upwards or downwards next to it.  This corresponds to whether you want to change the letter to 
upper or lower case.  Press on the highlighted character again to alter the case.  To add spaces 
to the edited text, touch on the editing area where you want the space added and press the 
Space button.  To make a carriage return, press the Enter button.  When you are happy with 
what you have typed and want to commit the text, press the Send button. 
 
Converting handwriting to text without using SMART Keyboard 
 
There is also the ability to convert your handwriting into text without having to open the 
Handwriting Recognition Window in the SMART Keyboard function.  When you have written on 
the SMART Board, by pressing and holding on the text on the SMART Board for one second 
with your finger a small menu will appear with the option Insert “(what you have written)” 
Here.  This “press and hold” method will convert your handwriting to text. 
 

 



Recording your interactions with the SMART Board 
 
The SMART Board is able to record interactions that you make on a SMART 
Board with the projection from the laptop.  If you have a microphone 
attached to the computer, you can also record your voice as part of the 
recording.  This is useful if you want narration over your file playback if you 
are presenting this recording to an audience.  By default this recording is 
saved as a Microsoft Video file (.avi).  Click the SMART Board icon and 
select Recorder, or the Recorder button in the Start Centre.  This will open 
the SMART Recorder. 
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To change the default settings of the SMART Recorder go to Menu, 
then Options.  Here you can change the video and sound quality of 
the recording in the Recording Quality tab.  If you do not wish to 
have narration over the recording, change the sound quality to No 
Audio. 

 
On the Video Format tab you can choose whether to save the 
recording as a Microsoft Video file, or a SMART Recorder Video file.  
The SMART Board Recorder Video format uses 16 million colours 
rather than the 256 colours of the Microsoft Video file which results in 
better quality, but this file can only be viewed on a computer which 
has the SMART Video Player on it.  The Target Files tab is where 
you can change the name of the file and the location on the hard drive 
where it is to be saved to. 

Saving still images from the SMART Board 
 
Click on the Camera icon in the Floating Tools menu. This will create a 
snapshot of the laptop screen, as well as any notations made over the 
top of it made with the SMART Board.  If you only want to save a partial 
area of the screen, click on the Capture Area icon in the Floating Tools 
menu and click and drag over the part of the screen which you want to be 
captured.  The SMART Board uses a program called Notebook to store 
all images that are saved.  When an image is saved from the SMART 
Board, Notebook opens automatically.  From Notebook, you will be able 
to specify what type of file you wish to save your capture as by clicking 
on the Export option from the File menu. 

 

Camera 
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Screen capture using Camera tool  

The screen capture is imported into Notebook 



 
Area capture tool.  The grey box signifies the area that 
has been specified to send to Notebook.  This box is 

created by clicking and dragging with the mouse or your 
finger on the SMART Board. 

 
The area capture is imported into Notebook. 

 

 
The Export as… function in Notebook. 

 

Save as a HTML, PDF, JPG, PNG, GIF or BMP. 
 
SMART Video Player 
 
The SMART Video Player is convenient for occasions when the user 
wishes to annotate over the top of video files.  The SMART Video 
Player recognizes all video formats that can be viewed in Windows 
Media Player.  The Video Player however does not recognize the 
internal DVD drives on the computer or streaming video from the 
internet.  If you wish to use content on the DVD drive or online video 
you will need to use Windows Media Player or another video viewing 
program.  To open the Video Player, click the SMART Board icon and 
select Video Player.  To configure the Video Player, click on Options, 
then select Video Player Settings. 
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With the Pause when Tool(s) Lifted setting on, whenever a marker or 
eraser is lifted from the pen tray the video will automatically pause.  If 
you wish to save the annotations that you have made over the video, 
click the Capture button on the toolbar at the bottom of the screen.  
The video that is playing will then pause while the screen capture is 
saved into Notebook.  To delete annotations that you have made on the 
screen over the video file, click the Clear button.  This button alternates 
between the states Clear and Restore, which is used if you mistakenly 
remove annotations that you want kept on the screen. 



 
SMART Video Player is able to receive output from external device such as video cameras, 
projectors, scanners and document cameras.  If one of these types of devices is connected to 
the computer, it is detected by SMART Video Player and is listed under the File menu of the 
player.  To view the output from the external device in SMART Video Player, go to the File 
menu and click Select Video Hardware.  To select a video format for output, go to the Options 
menu and select Video Source Settings. 
 
SMART Board Notebook 
 
There are three ways to open the Notebook program.  You can click the 
SMART Board icon and select Notebook, or click the Notebook button on 
the Start Centre, or click SMART Notebook icon on the desktop.  
Whenever you make a screen or area capture, Notebook will also open 
automatically if it currently isn’t already open.  The Notebook program is 
mostly used for putting together documents to be used for presentations, 
much like Microsoft PowerPoint.  All screen captures of annotations that 
are made from the SMART Board are automatically imported into the 
Notebook program.  
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On the right hand side of the Notebook window, there are three tabs labelled Page Sorter, 
Gallery, and Attachments.  The Page Sorter view is the default view, and is where you are 
able to view and edit all pages that are currently in your Notebook document.  The Gallery view 
is where you can access images, audio files, video files, and Flash animations from your 
computer as well as online.  These different types of content are placed in categories to help 
you find the item that you wish to add to your Notebook document.  The Attachments view is 
where you can import your own images or documents in order to insert them into the Notebook 
document. 
  
In addition to importing your saved annotations from 
the SMART Board, Notebook can also import 
documents from Microsoft Word, Excel, PowerPoint, 
and Adobe Acrobat.  Under the Print menu of the 
program you are using, the option to print using the 
SMART Notebook Print Capture rather than a 
physically connected printer will send the pages of the 
document to the Notebook program.  If you do not 
have Notebook open at the time the program will open 
automatically.  You can also send the contents of a 
web page by following the same process to print from 
the web browser. 
 
If you have a scanner attached to the computer you 
can also import the scanned image directly into Using SMART Notebook Print Capture from 

Microsoft Word  



Notebook.  To import from the scanner, go to the 
Insert menu in Notebook and select Picture from 
Scanner, then Select Source.  Pick the scanner that 
is attached to the computer on the list and then press 
the Select button.  Then go the Insert menu, select 
Picture from Scanner and then select Acquire.  The 
scanned image will then appear in the Notebook 
document.  From the Insert menu it is also possible to 
insert other graphic files or Notebook templates on 
your computer.  Position the mouse over the 
Picture/Template option, then select From File….  
Every time something is imported into a Notebook 
document, the new item is saved onto the current 
page that you have open in the document. 
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Page Sorter view in Notebook 
 
In Page Sorter view, miniature images of each page in the 
Notebook document that you have open will appear next to the 
Page Sorter tab on the right.  By default, the title of each page 
in the document is the date and time that the page was 
created.  To change the title of each page, double-click on the 
current title of the page on the Page Sorter tab and type in the 
new title. 
 
Apart from using the SMART Board markers to draw in 
Notebook, you can also insert objects into the Notebook 
document by using the attributes in the Draw toolbar.  This is 
especially useful if you are using the Notebook program on 
your personal computer to create a Notebook presentation for 
the SMART Board, and do not have a SMART Board attached.  
The Draw toolbar has options allowing you to draw in freeform 
with the pen tool, the creative pen tool which lets you draw 
lines with preset patterns, erase, draw line, and draw geometric 
shape. 

 
 

 
Changing title of page 

 

 
The Draw toolbar 

 
To draw on the Notebook document using the Draw toolbar, select the object from the toolbar 
and click and drag over the part of the document where you want the object to appear.  You can 
also change the attributes of the object that you want to place in the document, such as the 
colour, size, or transparency.  To change the attributes, click the object that you want to change.  
In the top right hand corner of the object that you have selected, a button with a downward 
arrow will appear.  Click on this button to bring up a list of options for that object.  At the bottom 
of this list is the Properties option.  When this option is selected, you can change the object’s 
attributes. 
 



Drop-down menu of object 
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Besides the drop-down menu in the top right corner of the object when it is selected, a green 
circle at the top of the object and a white circle in the bottom right corner will appear.  The green 
circle is the rotate button, and the white circle is the resize button.  Click on the circle and drag 
the object to whichever size or orientation that you want. 
 
When you wish to present material in the Notebook program to an audience, you most likely 
would want to have the screen clear of all toolbars and other material.  To maximise the 
available workspace on the screen, go to the View menu and select Full Screen, or press the 
Full Screen icon on the toolbar at the top of the screen .  The menu bar and title bar at the 
top of the screen will disappear, leaving just the toolbar.  To return to the normal view, press 
Escape on your keyboard or press the Full Screen icon on the toolbar again. 
  
Gallery view in Notebook 
 
Entering the Gallery view tab in Notebook allows you to access the 
graphics and multimedia files that are stored in the content folder for 
Notebook on your hard drive.  You are also able to import other graphic 
and multimedia content from your hard drive or from the web from this 
view.  Click on the gallery tab on the right of the screen.  Two windows 
will appear on the right of the screen.  The top window contains the 
categories of content that are available in the Notebook folder.  At the 
bottom of this list is the category called My Content.  If you are importing 
multimedia content into Notebook from another location on your 
computer’s hard drive than the Notebook folder, or downloading content 
from the web it is recommended to import this content into the My 
Content category.  To import graphic or multimedia content into Notebook 
click the Add/Import button which is above the Categories window.  You 
will then be prompted what type of file you are trying to import, as well as 
offer the option to add a new subcategory to the My Content category.  
This is useful if you are importing a lot of different types of files. 
 

 Gallery view 



When you click on the name of a category in the top window, the contents of that category are 
shown in the window below it.  There are four different types of content that can be placed in the 
Notebook document, and the different types are represented graphically in this window. 
 
When the image in the gallery window does not have anything in the corners it is a 
regular image. 

When the image in the gallery window has the top right-hand corner folded over, it 
means that this item is a template file.  When this item is added to the document it 
will create a new page and place this template on it.  You are then able to place 
images and text over this template. 
 
When the image in the gallery window has a red “f” in the top left-hand corner, it 
means that this item is a Flash animation.  The Flash animation will play 
automatically when you place it in the Notebook document. 

SMART Board aware programs in Windows 
 
Whenever you are running a program on the laptop that is SMART Board aware, it is possible to 
make notations or drawings that you make on the SMART Board a component of the program, 
rather than markings over the top of it.  For example, if you write something on the SMART 
Board while Microsoft Word is open in the background, you can save your writing into Word as 
typed text rather than having the writing in pen saved over it.  After writing on the SMART 
Board, you can use the press and hold method to insert your writing as text in the SMART 
Board aware program, rather than having to open the SMART Keyboard.  Programs that are 
SMART Board aware include: 
 

• Microsoft Word 
• Microsoft Excel 
• Microsoft PowerPoint 
• Adobe Acrobat 

• Microsoft NetMeeting 
• Microsoft Paint 
• CorelDraw 

 

 
Pressing and holding on writing on SMART Board while Microsoft 

Word is open in the background 

 
The writing has been converted to text in 

Microsoft Word. 
 
 



Microsoft Word and Excel using SMART Board 
 
With either Microsoft Word or Excel open, when you pick up a marker from the SMART Board 
pen tray a small toolbar will appear.  This toolbar offers four functions.  The camera icon and 
capture area icons react in the same way as that of the Floating Tools menu.  The third button 
from the left as the Save Annotations button.  This will save what you have written as a 
drawing inside the Word/Excel document.  The fourth button is the Save Annotations as Text 
button.  This button converts your handwriting into text that is inserted into the Word/Excel 
document. 
 
Exiting SMART Board 
 
Double-click the SMART Board icon and select Quit. 


